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UNIVERSITY OF WASHINGTON ETHNOMUSICOLOGY ARCHIVE:
/8 RPM DIGITAL LIBRARY

The UW Ethnomusicology Archive contains a collection of approximately 1,000 78 rpm records. Many of
these records have not been cataloged and some are waiting for processing. As full processing of these
records moved forward, the archive began to look for ways to provide access to the content of each 78 rpm

record.

To fully provide access to this material, the archive wanted to pursue a solution that would allow users to
view the descriptions of each record and its contents, scanned image files associated with the record, and

download digitized sound files of the records contents.

ABOUT GREENSTONE DIGITAL LIBRARY SOFTWARE

e The Greenstone Digital Library software was chosen for this project for a number of reasons:

e Itis simple to use presents collections for viewing in a web browser

e The server installation allows for easy publishing on the web

e The software can manage multiple collections; if the archive decides to present more collections
through Greenstone (such as department performances), this manual can be used to create new
collections

e It can be highly customized to meet the needs of the archive.

This manual outlines all aspects of developing the 78 rpm record collection using the Greenstone Digital
Library software. It also includes the full metadata schema designed to support presentation of bibliographic
information of each record. This metadata schema should be consulted to understand the scope, audience
and functionality the digital library aims to provide. It will also be a useful reference if the collection moves

to a new platform in the future.

The manual will also cover both local and server installations and current customizations. Lastly, the manual
contains detailed cataloging instructions for creating and managing the HTML, jpg and mp3 files that
represent each 78 rpm in the digital library.



INSTALLATION

GREENSTONE DIGITAL LIBRARY SOFTWARE

Greenstone can be downloaded from the following web site:

http:/ /www.greenstone.org/download

This project was built using Greenstone 2.8. While Greenstone 3.0 is available, it is not necessary to upgrade

the library to version 3.0 at this time.

To install, follow these steps:

A Al o

Greenstone may need you to identify Java Runtime Environment upon installation. You will know
that it has not found Java if it tells you that it cannot find an appropriate JVM. If it asks for a JVM,
navigate to:

<your computer>:\ \Program Files\Java\<your version of java>\bin\java.exe

[note: Greenstone needs Java RE version 1.4 or higher]

Select the language for this installation.

Welcome to the InstallShield Wizard for the Greenstone Digital Library Software. Click <Next>
License Agreement. Accept the agreement and then click <Next>

Choose whether this will be a local or web installation and click <Next>

Choose location to install Greenstone. Leave at the default and click <Next>

Setup Type. Leave at the default (Local Library) and click <Next>

Set admin password. The admin password is set to "admin" by default. Delete "admin" and type in

the new password. <Next>

10. Click <Install> to complete the installation

11. Installation is complete.

IMAGEMAGICK

To process image collections, Greenstone requires an image processor. The name of the processor that

Greenstone uses is ImageMagick. If you do not install ImageMagick, and then open Greenstone, you will be

warned that you can build collections, but that they will not be able to contain images.

Download ImageMagick from:

http://www.imagemagick.org/.



To install this program you must have Windows "Administrator" privileges on the machine that you are
installing it on. (If you do not have Windows Administrator privileges, the ImageMagick installer will
produce an error and not install properly. If this happens you can continue your work with Greenstone, but
you will not be able to build collections of images.)

To install, follow these steps:

"This will install ImageMagick. Do you wish to continue?" Yes

"Welcome to the ImageMagick Setup Wizard Click <Next>

"Information: Please read the following ..." Click <Next>

"Select Destination Directory ..." Leave at default and click <Next>
"Select Start Menu Folder ..." Leave at default and click <Next>

"Select Additional Tasks ..." Leave at default and click <Next>

"Ready to Install". Click <Install>

"You have now installed ..." Click <Next>

"Setup has finished ...". Deselect "View index. HTML" and click <Finish>.

Yook N

JAVA RUNTIME ENVIRONMENT

To use the Greenstone Librarian Interface, you need a suitable version of the Java Runtime Environment. If
you don't already have this, you can download the latest version from
http://java.sun.com/javase/downloads/index.jsp. Greenstone needs version 1.4.0 or higher. (The current
version as of initial install is 1.6_05)

APACHE WEBSERVER

The Ethnomusicology Archive is currently installed on a server machine managed by the music department.
Questions about the web server itself should be directed to:

Colin Todd; 206 543-0543; Box 353450
Senior Computer Specialist, School of Music
cmt@u.washington.edu



ACCESSING GREENSTONE COLLECTIONS

Once Greenstone is installed for the first time, you can view the demo collection.

To view the collection:
1. Go to Start/All Programs/Greenstone Digital Library Software v2.8/Greenstone Digital Library
2. You will see a small window open with the button "Enter Library"
3. Click this button to open the Greenstone Welcome page in a web browser.

The Greenstone Welcome page is the main interface for viewing collections over the Internet. The top of
the page contains links to each collection available for viewing.

The next section contains links to information about Greenstone. The Administration allows administrators
to manage users, view configuration files and error logs, and access other programming functions. The
administrator username is “admin” and the password is "tempo," the same one that was chosen when
Greenstone was installed. For example, by selecting protocols underneath Technical information, one can
view the HTML, Perl, and macros used to create the displays for search pages, indexes, and metadata
records.

VIEWING COLLECTIONS

When installing Greenstone for the first time, the only collection to view is "Greenstone Demo"
To view the "Greenstone Demo" welcome page for that collection, simply click the icon for the collection.

SEARCHING THE COLLECTION IN GREENSTONE

The Ethnomusicology Archive 78 rpm collection can be searched and browsed in a number of ways.

The welcome page has a horizontal navigation bar across the top of the page. Here you can decide to search
on specific terms or browse the collection by a number of different criteria.

The default search allows users to combine search terms to find items in the collection. For example,
someone could search a record under the Publisher "Balkan Records" and part of a Matrix Number



"1490A", to find a known record. Above the search fields is an option to search on some or all of the
selected search terms. Choosing some will search using a Boolean "OR" operator, returning all records that
have any one of the search terms. Choosing all will search using a Boolean "AND" operator, only returning
records that have all of the selected search terms.

The Ethnomusicology 78 rpm collection can also be browsed using the following criteria:
e Instrument
e [Language
e Subject
e Geographic Region

By selecting one of these options from the navigation bar, Greenstone will display all records in the
collection, grouped by the criteria selected. For example, selecting instrument will produce a list of
instruments that appear on recordings in the collection. By clicking on an instrument, for example, guitar,
you can display links to each record on which a guitar appears.

For details on creating search and browse indexes see XXXXX



USING THE GREENSTONE LIBRARIAN INTERFACE TO BUILD AND
EDIT COLLECTIONS

GREENSTONE LIBRARIAN INTERFACE (GLI) BAsICS

The GLI allows administrators to build and edit collections in Greenstone. You can open the GLI by going

to:
Start Menu—> All Programs=> Greenstone Digital Library=> Greenstone Librarian Interface

The GLI opens in three steps: first the command window will open (you will not use this window, but it
must remain open while you are working in the GLI), next the “Enter Library” pop-up will open, and last
the GLI itself will open. Be patient — the can sometimes take a moment or two.

There are six tabs across the top of the GLI that allow you to work with different aspects of collections:
Download: This tab allows you to download resources from the Internet to add to your collection. The 78
rpm collection does not use this function.

®  GatherThis tab allows you to add files to new or existing collections

e  Eunrich:This tab is where all of Greenstone’s metadata is managed

®  Design:This tab allows you to customize the search and browse indexes for the Greenstone User

Interface

®  Create: Use this tab to build and preview collections

®  Format:The tab that allows management of display macros and search and browse indexes.
Functionality within each of these tabs is addressed in the following sections on building the
Ethnomusicology 78 rpm Collection.

CREATING THE COLLECTION

CoLLECTION 101

The collection must be built before any customizations can be made. Initially, this collection was built on a

suite of files that made up 10 item records.

To build the 78 rpm collection, follow these steps:
1. Go to File>New
2. A new collection box will open up
3. For the title, enter: Ethnomusicology Archive - 78 rpm Collection
4. In the Description of Content enter the following text (including HTML tags):
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5. The University of Washington Ethnomusicology Archives collection includes hundreds of 78rpm
records containing music from a variety of classical, folk, popular, and indigenous music traditions
around the world. Many of these records were acquired during the field research trips of Prof.
Robert Garfias during the 1960s and 70s. Many more have been donated over the years by other
ethnomusicologists and private collectors. Among the geographical/cultural areas represented are
Japan, China, Nepal, India, Romania, Latin America, Bali, Lithuania, Greece, Burma, Thailand, the
Middle East, Turkey, West Africa, Sweden, Oceania, Native North America, and the United States.
<p>

For more information, contact:

<br>University of Washington Ethnomusicology Archives
<br>ethmusic(@u.washington.edu</p>

Then next to Base this collection on, select “New Collection” from the drop down

Click OK

You will see a prompt that the collection is being created

©° ® N

Once the collection has been created, you will see the collection name in the top of the GLI title bar
and the Collection side of the GLI will turn from gray to green

DEFINING ADMINISTRATIVE SETTINGS

There are some basic administrative settings that should be defined for every collection. These include user
privileges and contact information for the collection.

Administrative privileges are set through the Preferences. Find preferences by going to File=> Preferences.
The window opens to the General tab. In the General tab, set the User’s email address.

Next, go to the Mode tab. Here you can decide which editing privileges you need to modify the collection.
For the 78 rpm collection, the user mode should be set to Experz. Once that has been selected, click Apply
and then OK.

The Mode will appear in the title bar of the GLI just before the collection name. This ensure that when you
open the GLI, you will know which editing mode you are using.

IMPORTING ITEMS INTO A COLLECTION

You can now add files to the collection in the Gather tab.
1. Open Local Filespace
2. Navigate to the directory on the hard drive containing files for the library
3. Select the files and drag them with the mouse into the Collection window

11
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Figure 1

The 78 rpm collection will contain HTML, JPG, and MP3 files. When preparing these files for the
collection, they should all be kept in one folder. Likewise, these should all be moved into the main
Collection folder on the right hand side — they should not be in any kind of subfolder structure. This is
necessary to maintain links between the files for display in the collection. See Figure 1 for an example of
how the files should look in the collection.

USING THE CREATE TAB TO BUILD THE COLLECTION

Now that we have documents in the collection and administrative privileges have been set, we can generate
an initial build of the collection. To do this:

1. Go to the Create tab

2. Select Build the Collection

You can also preview the collection now as well. You will notice that because the Document Plugins have
not been configured that not all of the files have been processed properly. The search and browse indexes
also need to be built to the collections specifications. These set-up tasks are addressed in the following
sections.

DOCUMENT PLUGINS

WHAT IS A PLUGIN?

One of Greenstone’s strengths is that it can build a collection on many different kinds of text and media
documents. These different file formats are processed by Greenstone Document Plugins. There are many
ways that or Greenstone can extract metadata through Plugins: using styles to extract metadata from word
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documents, extracting technical metadata based on information embedded in the file itself. The 78 rpm
collection uses an HTML template that links to associated JPG image files and MP3 sound files.

CONFIGURING DOCUMENT PLUGINS FOR THE 78 RPM COLLECTION

Greenstone comes with a suite of default Document Plugins installed. The 78 rpm collection does not need
all of these plugins, so some of them can be deleted. Other plugins need to be added or configured for the

collection to function propetly.
View the Plugins by going to Design=>Document Plugins

The following default Plugins can be deleted from Greenstone for this collection:

Z1PPlug
TEXTPlug
EMAILPlug
PDFPlug
RTFPlug
WordPlug
PSPlug
ISISPlug

9. NULPlug

© Nk N =

That should leave these six plugins:
1. GAPlug

HTMLPlug

ImagePlug

MetadataXMLPlug

ArcPlug

RecPlug

R

The 78 rpm collection needs one more plugin to process the collection: MP3Plug. To add this plug in, select
MP3Plug from the drop down menu under the plugins, click Add Plugin..., click OK.

You will now see MP3Plug at the bottom of the list.
Greenstone needs to process the plugins in a specific order to make sure that all of the collection files are
linking properly. For the 78 rpm collection, HTMLPlug, ImagePlug, and MP3Plug need to be the first

plugins to process files.

You can change the order of the plugins by selecting a plugin and then choosing “Move Up” or “Move
Down” on the right hand side of the GLI. The plugins should be arranged in the following order:
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HTMLPlug : processes HTML files for each item description

ImagePlug: processes associated image files linked from within the HTML file.
MP3Plug: processes mp3 sound files linked from within the HTML file.

GAPlug: processes XML data created by Greenstone during the collection build process

oA b=

MetadataXMLPlug: The 78 rpm Collection does not use this plugin that processes XML documents,
but it cannot be removed

ArcPlug

7. RecPlug

o

One last modification needs to happen. The HTMLPlug needs to be configured to process the items in this
collection.

Configure HTMLPlug by:
Selecting the plugin and then choosing “Configure Plugin...”

Select the check box next to metadata_fields. The text box should contain the names of each metadata
element separated by a comma with no space. This will tell Greenstone to look for these metadata elements
when processing the documents, and allow the collection to build search and index tools with them.

The following text string should be entered there:
title,albumTitle,seriesInfo,inventoryNumber,collection,matrixNumber,aloumNumber,issu
ed,labelLanguage,note,accompanyingMaterial,physicalDescription,publisher,perfBy,instr
ument,musicalWorkTitle,alternative,performancelLanguage,composer,lyricist,subject,cov
erage

Next, scroll down to assoc_files. The following text string should be present:

D\ (gif |jpergipe|jpg| png|ess)$

This tells us which files associated with our HTML files will be processed. The default setting includes many
types of image files and cascading style sheets. However, we need to add MP3 to the list to ensure that it will

also correctly process links to our sound files.

Edit the associated file string by clicking on the check box next to assoc_files, deleting the text string, and
copying and pasting the following:

C)\.(gif|iperg|ipe|ipg| png|css | mp3)$

Now that we can process the MP3 links in our HTML files, we need to make one more change to the
default settings to finalize the HTMLPlug configuration.
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Scroll down to the section called BasPlug. The first check box under BasPlug is called smart_block. If we
leave smart_block on, every image and sound file will be enumerated in our search and index results in
Greenstone. We only want them to be viewed withint the HTML files display and do not want to search on
them separately. By unchecking the smart_block box, we will make sure that stray media files do not show
up in the search or index results.

The HTMLPlug is now configured. Close the configuration window by clicking OK.
If you have already added documents to the digital library, go to the Create tab and build and preview the

collection. Keep in mind that the search and browse settings have not been configured yet when previewing
the collection.
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MANAGING METADATA IN GREENSTONE

Each collection in Greenstone has two default metadata schemas when it is initially built: Dublin Core
Metadata Flement Set (dc) and Extracted Metadata Element Set (ex). Dublin Core currently allows for
manually adding metadata associated with the fifteen core elements in the schema. The Extracted Metadata
is created when documents are ingested and is dependent on the plugin configurations that were completed
in the previous section of this manual. Metadata in Greenstone is managed through the Enrich tab on the
GLIL

VIEWING AND EDITING DEFAULT METADATA SCHEMAS

You can see the metadata associated with a collection by going to the Enrich tab. If you have already
followed the instructions and built a collection, you will be able to click on each individual file in the
collection and view the metadata associated with that file. When you first view this information, you will see
each of the Dublin Core elements enumerated for the file, but with no values. There will only be values in
the Extracted metadata (those that start with ex).

If you have not added any files and built a preliminary collection, you will see an empty collection window
with no values selected on the right hand side of the panel. You can complete the following steps before
processing files through the Create tab and building the collection, but you will not be able to view metadata
for files as described below.

We could manually enter Dublin Core metadata in this section of the GLI, but the extracted metadata for
this collection has been built on the schema defined in Appendix A. (Read the schema in full to see how
individual elements could map to Dublin Core metadata). Because all of the metadata necessary for the
collection has been extracted, we can remove Dublin Core from the collection.

1. Click on “Manage Metadata Sets”

2. Select Dublin Core from the Assigned metadata sets

3. Click on “Remove”

4. Select Close

Now when you select a file from the collection, you will only see extracted metadata associated with that
file.

CoDING METADATA INTO HTML FILES FOR PROCESSING

This is covered in detail in the section “Creating Metadata Records Using the Ethnomusicology Greenstone
Template”
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CREATING AND FORMATTING SEARCH AND BROWSE INDEXES

Greenstone allows designers to customize its search and browse functionality to best serve the material in
the collection and the users who will need to access it. This is done by associating metadata elements with
different aspects of the search and browse functions.

SEARCH INDEXES

The search indexes in Greenstone control what metadata elements users can search on through the
interface. For example, if you want users of the library to be able to search on Titk, it needs to be defined
through the search indexes.

To view the search indexes, go to the Deszgn tab in the GLI. Underneath Document Plugins, you will see Search
Indexes. Open up Search Indexes to see the default Assigned Indexes. Each Assigned Index controls a search
option in the Greenstone User Interface.

The default Assigned Indexes in Greenstone are:

o Text [Defanlt Index]: This searches all text of any documents in the collection that contain text. For
example, it does not search image files or sound files. The [Default Index] in brackets tells us that
this index will be the default in the search box when users search Greenstone.

o ox.Title: This index searches any titles extracted from the files themselves.

e ex.Source: This index searches items in the collection based on their filenames.

The only default index that the 78 rpm collection needs is the Tex? index. This will allow users to search the
text in the HMTL files independent of its label. This can be useful for people searching on different
numbers associated with an album (it can often be confusing deciding which number is a matrix number
and which numbers are not). The extracted title and source indexes are not useful to the 78 rpm collection
users and should be removed.

Remove these indexes by selecting them in the list and then clicking “Remove Index...”

When you select Texzand then click “Edit Index...” you can see all of the extracted metadata fields that are
being searched across. Some of them may look unfamiliar — this is technical metadata about the files that
Greenstone has extracted in addition to the descriptive metadata that is in the HTML files. Users are

unlikely to search on these elements, you can leave them in the text search.

The 78 rpm collection has these additional Assigned Indexes that should be built:

1. album.Title

2. collection

3. coverage

4. inventoryNumber
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performancelanguage
matrixNumber

perfBy

publisher

subject

e R IR

Creating new Assigned Indexes is simple:
1. Select “New Index...”
2. Check the box next to the element that you want to create a search index for
3. Click “Add Index”
4. The index will appear in the list of Assigned Indexes

The order that the Assigned Indexes appear in on the GLI determines the order they will display in the drop

down when users search. For the 78 rpm collection, indexes should be re-ordered to display in the following

otder (if you entered them in the order they appear above, you should not need to re-order them in the list):
1. album.Title

collection

coverage

inventoryNumber

performancelanguage

matrixNumber

perfBy

publisher

e A ol o

subject

If you built the collection now and looked at the search drop down, you would see the elements as they
appear above listed in this drop down. However, many users will not known what perfBy means, so the
display labels need to be changed.

The display labels can be formatted on the Format tab of the GLI. Once you open the Format tab, choose
Search from the menu on the left. A table will display with the elements in the Assigned Index on the left and
the display text on the right. Change the display text for each element to read:
1. Text
Album Title
Collection
Geographic Coverage
Inventory Number
Language
Matrix Number
Performer
Publisher

e A Al o
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10. Subject

The search indexes for the 78 rpm collection are now complete.

BROWSE INDEXES

Browsing indexes allow library users to click on a navigation link at the top of the collection homepage and
browse the collection by selected criteria. Browse indexes are built on specific metadata elements that are
designated as Browsing Classifiers in Greenstone.

Browsing Classifiers are also managed through the Design tab in the GLI. Browsing classifiers are found at the
bottom of the Deszgn tab menu. When you click on Browsing Classifiers, you will see the default Asszgned
Classifiers that are built into Greenstone collections.

The AZList-metadata ex.Title and AZList-metadata ex.Source create browse indexes that are arranged A-Z
for extracted title and extracted filename information. These are not browse indexes that are useful for the
78 rpm collection. Delete them by selecting them on the panel and clicking “Remove Classifier...”

Add new browsing classifiers following these steps:
1. Select classifier to add: Choose AZCompactList
2. Select the metadata element that will be browsed (ex.coverage, ex.performancel.anguage,
ex.coverage, etc.)

3. Scroll down to the button_name. Check the box and select the appropriate button name.

The 78 rpm collection should contain the following AZCompactList browsing classifiers:

Metadata Element Button Name
ex.instrument Instrument
ex.peformancel.anguage Language
ex.subject Subject
ex.coverage Coverage

It is important to make sure that you use AZCompact list rather than AZList for the 78 rpm collection.
AZCompactList will group together all of the items that have the same metadata value. For example, when
you see “Piano” in the AZCompactList browse and open it, your results will list all of the records that have

a value of “Piano” in the metadata element instrument. This improves navigation for the collection.
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CUSTOMIZING DISPLAY AND PRESENTATION

Greenstone allows a lot of customization for presentation. At this time, the 78 rpm Collection has decided
to focus on presentation details that directly address usability. If there is a decision to further customize the
appearance of this Greenstone Collection, see the resources in Appendix C.

HOME PAGE AND ABOUT PAGE BUTTONS

In the demo collection that is built into Greenstone, you may notice that there are images on the main
Greenstone home page and on the collection home page representing the name of the collection. There is
an online web page where you can format these images for customized collections.

All of the image files associated with the collection will be located in the following directory:
Greenstone\collect\ <specific _collection_folder>\images

Then name of the specific_collection_folder is the folder where the 78 rpm collection is saved within
Greenstone; it always displays in parenthesis in the title bar of the GLI directly after the collection name. It

can also be found in the Formzat tab under General settings.

To create custom buttons for the 78 rpm collection, you need to create the images and save them to the file
location above. You can currently create these images online at:

http:/ /www.cs.waikato.ac.nz/~1h92/ereenstone/image-generation/make-images.html

There are two options for creating images: browse buttons and collection general images. The browse
button images are automatically generated in current versions of Greenstone. However, when you enter the
Greenstone home page, the 78 rpm collection does not have an image link, and the collection home page is
not well formatted — the title is just splayed across the top.

By creating collection images, we can make these displays more unified within Greenstone. Create the
images by filling out the collection image form with the following values:

e Language interface: English
e Collection internal name: 78 rpm collection

e Text to appear on collection icons: Ethnomusicology\n78 rpm collection
The “\n” in the icon text will make sure that everything that follows appears on a second line.

Once you click “Go,” the images will appear on a new web page that gives instructions for adding the
images to the collection. First, save the images:
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e Right click the first image
e Save it in Greenstone\collect\<specific _collection_folder>\images

e Repeat for the second image

Next, add them to the collection
Go to the Format tab

e Next to the line that says “URL to ‘about page’ image, select the “Browse...” button
e Navigate to the file folder and select the image 78rpmcollection.gif
e Next to the line that says “URL to ‘home page’ image,” select the “Browse...” button

e Navigate to the file folder and select the image 78rpmcollection_sm.gif
Now the images will appear on the collection pages.

To customize these with different images in the future, follow these steps by saving the images to the image
folder within the collection and then adding them to the collection information through the Formnat tab.

CUSTOMIZING DISPLAY OF INDEXES, SEARCH RESULTS, AND LIBRARY RECORDS

Greenstone uses a combination of HTML, CSS, Perl, and macros to generate the HTML pages that library
users see when they navigate the library. The previous section discussed how to customize the metadata that
would be used for these actions in the database. This section will specifically cover display issues in

Greenstone.
At the time this manual was written, the decision was made not to customize the pages beyond the
instructions that follow. If further customization is undertaken in the future, this manual should be updated

with any details necessary to rebuild the collection in Greenstone.

References for further instruction to customize Greenstone appear in Appendix C.

FORMAT FEATURES

Most changes to the display of Greenstone are managed in the Format tab under “Format Features.” This
section displays the first sections of the collection that we will be modifying. The Features that can be edited

here are:
e VList: Controls how the record reference displays vertically in results lists.
e HList: Controls how the record display horizontally in results lists.
¢ DocumentHeading: Controls the way that the header for a document displays
e DocumentText: Controls the display of metadata associated with a file in the collection.

e DocumentButtons: Controls images that help library users navigate text-based items that have
multiple pages.
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e Secarch Types: controls how the search function displays for users
If you have followed the collection build process in this manual, you may have noticed that items in the
library are displaying as Untitled with the file name underneath in italics. The first thing we need to do is
change the source code that controls what displays here so that library users will see the title of the record
album and no file name (The file name is not something that the majority of library users will understand
when they see the display.)

The vertical list display should be changed to show the album title for each document. To make this change:
1. Choose VList
2. Choose Features: All Features (This changes every appearance in the library, which we want to do)
3. Affected Component: VList
4. The default text in the HTML Format String reads:

<td valign="top">[link][icon][/link] </td>

<td valign="top">[ex.strclink] {Or} {[ex.thumbicon],[ex.stcicon] } [ex./stclink] </td>
<td valign="top">|highlight]

{Or} {[dc.Title],[exp.Title],[ex. Title],Untitled }

[/highlight] {If} {[ex.Source],<br><i>([ex.Source])</i>} </td>

5. Delete this string and copy the following in its place:
<td valign="top">[link][icon][/link] </td>
<td valign="top">|highlight]
{Or} {[ex.albumTitle],[ ex.Title],Untitled }
[/highlight]</td>

Now you can preview the collection and see that the parenthetical file names are gone, and album titles
appear next to the document icon.

We do not need to edit HList because we do not have any horizontal classifier displays.
The next Format Feature we need to adjust is DocumentHeading. We do not need any customized
document headings because all the display in the 78 rpm collection is coded into the HTML files. Select

DocumentHeading and then delete the text that appears in the HTML format string.

DocumentButtons allows users to detach the HTML file from the library to look at it or to control
highlighting for search terms. We do not need to change the default settings for this Format Feature.

There is also no need to modify the DocumentText format feature.
The final change needed for the 78 rpm collection is to update the SearchTypes options. Users of the 78

rpm library should be able to search across multiple fields at once. To make this change, select SearchTypes
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and change the text from “plain,form” to “form,plain.” This will change the display to allow mutli-field
searching.

This completes the customizations for the current 78 rpm collection. For further information on
customization, see Appendix C.
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CREATING METADATA RECORDS USING THE ETHNOMUSICOLOGY
GREENSTONE TEMPLATE

OVERVIEW OF METADATA RECORDS

To display information in the digital library, a metadata record for each 78 rpm record needs to be created.
These records are created as HTML files from an existing template. This section of the manual will discuss
file naming conventions for HTML files and other associated image and sound files; editing the template;
saving records; and updating the library.

NAMING FILES FOR THE LIBRARY

File names for all files associated with a 78 rpm record are based on the UW Ethnomusicology Archive
inventory number. Each HTML record for a 78 may have one or more image files and one or more mp3
files associated with the record. The inventory number is a crucial piece of metadata that will keep file

associations consistent in the library.

To create a new metadata record and add it to the library, you should have three things:
1. All information needed to correctly complete the template
2. Any image files associated with the record
3. Any mp3 files associated with the record

Once you have this information, open the file 78rpm_template. HTML. This file is located at:
C:\Documents and Settings\ethnoarchive. MUSIC.000\My Documents\Greenstone Templates and Manual

The file will look like this:<insert screenshot>

The template will allow you to enter in metadata needed for search and retrieval in the library and format

the display information that users see when using the library.
To complete the template and prepare the files to be added to the library, follow these steps:

1. Save the template using the following naming convention: <inventoryNumber. HTML> The
inventory number is a unique number associated with the 78 rpm record. All file names associated
with this record should begin with the inventory number.

2. Name all associated image files. If there is more than one file, they should also be assigned

sequential numbers beginning with 1. For example, if you had two .jpg files for a record with
inventory number 123, the associated file names should look like this:
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a. 123_1jpg
b. 123_2,pg

3. Name all associated sounds files. If there is more than one file, they should also be assigned
sequential numbers beginning with 1. For example, if you had two .mp3 files for a record with
inventory number 123, the associated file names should look like this:

a. 123_1.mp3
b. 123_2.mp3

4. Open the template in a text editor like WordPad or Notepad, or an html editor like Dreamweaver or

Frontpage. Before editing, save the file as inventoryNumber.html. Now the file is ready to be edited
and added to the library.

ANOTE ON FILE SIZE

Specifications for preservation of all digital files are managed by the Ethnomusicology Archivist. For display
purposes in the digital library, all image files should be sized to 4 inches X 4 inches.

FORMATTING THE TEMPLATE HEADER

The template header controls the metadata that will be extracted from the file for search and retrieval in the
library. Use the following instructions and examples to complete the header information for each record.
The only metadata that is mandatory is the inventoryNumber, but it is recommended that the metadata be
completed as fully as possible.

The template contains one line of metadata for each potential value. Some records may have more than one
value, and in those cases, the full line of code should be repeated. For example, two matrix numbers should
not be added to one metadata field. The matrixNumber metadata should be repeated to list the additional
value. (See following examples) Any metadata that does not have a value should be removed from the
template.

No diacritics should be recorded in the header of the document, as that may impede the search functions in

Greenstone. Diacritics should only be used in the display portion of the template. See the section .4 Note on

Diacritics for more information.
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Step 1: Format the header title

To display a title in the Greenstone record display, the title needs to be set in the header. The
information from the title should come from the metadata field albumTitle.

This tag appears in the template as:

<title></title>
This title will appear in the upper left hand corner of the record and should reflect the aloum
title.

<title>Balkan 845</title>

Next, begin formatting the metadata tags in the header using the following examples as a guide.

Example 1: albumTitle

This tag appears in the template as:

<meta name="albumTitle" content=""">
The album title should be entered as it appears on the record between the empty “” marks. For
example:

<meta name=""albumTitle" content="Balkan 845>

Example 2:serieslnformation

This tag appears in the template as:

<meta name="serieslnformation" content=""'>
The series title should be entered as it appears on the record between the empty
example:

marks. For

<meta name="'seriesInformation”™ content=""Balkan Phonographs vol. 2>

Example 3: inventoryNumber

This tag appears in the template as:

<meta name="inventoryNumber" content=""">
The inventory number should be entered as it appears on the record between the empty *”
marks. For example:

<meta name=""inventoryNumber' content="310">
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Example 4: matrixNumber

This tag appears in the template as:

<meta name="matrixNumber"™ content=""">

The matrix number should be entered as it appears on the record between the empty “” marks.
If a matrix number for each side is available, create a new tag for each matrix number. For
example:

<meta name="'matrixNumber' content="845-A">
<meta name="'matrixNumber'™ content='"845-B">

Example 5:albumNumber

This tag appears in the template as:

<meta name="albumNumber' content=""'>

The album number is any number other than the matrix number that appears on the album. It
should be entered as it appears between the empty “” marks. If more than one album number
is listed, create a new tag for each matrix number. For example:

<meta name=""albumNumber' content="Balkan 845-A">
<meta name=""albumNumber' content="Balkan 845-B''>

Example 6: publisher

This tag appears in the template as:

<meta name="‘publisher™ content=""">
The publishing company should be recorded between the empty “” marks. For example:

<meta name="'publisher" content="Balkan Phonograph Records''>

Example 7: issued

This tag appears in the template as:

<meta name=""issued" content=""'>
The date issued should be entered as it appears on the record between the empty “” marks. For
example:

<meta name=""issued' content="1942">

27




Example 8: physicalDescription

This tag appears in the template as:

<meta name="'physicalDescription” content=""">

Information about the physical description should be recorded between the empty “” marks.
This includes the speed, playback mode, and size. The record size should be recorded in inches.
For example:

<meta name="'physicalDescription'” content="78 rpm, mono, 107”.">
Size should always be recorded in inches symbolized by .
Playback mode may only be one of the following values:

e mMono

e stereo

Example 9: note

This tag appears in the template as:

<meta name=''note' content="">
Any information of note from the album label, cover, or concerning the album’s condition
should be entered here. Notes should be entered between the empty “” marks. For example:

<meta name="labelNote" content="Recorded in Europe; Made in USA; Price - $1.00,
small piece of record broken off.'>

Example 10: accompanyingMaterial

This tag appears in the template as:

<meta name="'accompanyingMaterial' content="">
Notes about any accompanying material such as liner notes or record album inserts should be
recorded between the empty “” marks. For example:

<meta name="‘accompanyingMaterial’ content=" Cardboard album with notes on
inside front cover, photos on inside back cover'>

Example 11: labelLanguage

This tag appears in the template as:

<meta name=""labellLanguage' content="""'>
The language that text printed on the label of the record album should be recorded between the
empty “” marks. For example:

<meta name="'labellLanguage' content="Greek'>
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Example 12: musicalWorkTitle

This tag appears in the template as:

<meta name="musicalWorkTitle" content=""'>

Titles of musical works that appear on the album should be recorded between the empty “”
marks. There should be a separate entry for each musical work that appears on the record For
example:

<meta name=""musicalWorkTitle" content=""Dhiamandoula mou'>
<meta name="'musicalWorkTitle" content="Ousak Neva''>

Example 13: alternative

This tag appears in the template as:

<meta name="alternative' content=""'>

Alternative titles of musical works that appear on the aloum should be recorded between the
empty “” marks. There should be a separate entry for each alternative title associated with a
musical work that appears on the record. For example:

<meta name="'alternative'" content="Ela na se kano teri'>
<meta name="'alternative'" content="Amanes''>

Example 14: performancelLanguage

This tag appears in the template as:

<meta name="'performancelLanguage’ content=""">

The language of any spoken or sung text on the recording should be recorded between the
empty “” marks. There should be a separate entry for each language that appears on the record.
For example:

<meta name="'performancelLanguage' content="Turkish">
<meta name="‘performancelLanguage’” content="Greek'>

Example 15: perfBy

This tag appears in the template as:

<meta name="perfBy" content=""">
Performers that appear on the record should be entered in direct order. There should be a
separate entry for each performer that appears on the record For example:

<meta name="'perfBy' content="Roza Eskinazi'>
<meta name="'perfBy'" content="Miles Davis''>
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Example 16: instrument

This tag appears in the template as:

<meta name=""instrument" content=""'>
Instruments that appear on the record should be recorded between the empty “” marks. There
should be a separate entry for each instrument that appears on the record For example:

<meta name=""instrument”™ content="clarinet'>
<meta name=""instrument” content="bongos''>

Example 17: composer

This tag appears in the template as:

<meta name='‘composer' content=""'>
Composers that appear on the record should be entered in direct order. There should be a
separate entry for each composer that appears on the record For example:

<meta name="‘composer’ content="lannis Xenakis'>
<meta name="'composer' content="Fazil Say'>

Example 18: lyricist

This tag appears in the template as:

<meta name="lyricist" content=""">
Composers that appear on the record should be entered in direct order. There should be a
separate entry for each composer that appears on the record For example:

<meta name=""lyricist” content="Nazim Hikmet ">
<meta name="lyricist" content="Dimitris P. Kraniotis'>

Example 19: subject

This tag appears in the template as:

<meta name="'subject' content=""'>

Subjects reflect genres or other terms from the Ethnomusicology controlled vocabulary that
should be assigned to a record. There should be a separate entry for each subject that appears
on the record. For example:

<meta name="'subject' content='"'Songs''>
<meta name="'subject” content="Folk Music--Turkey">
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Example 20: coverage

This tag appears in the template as:

<meta name=''coverage' content='"">

Coverage should reflect the geographic area associated with the recordings. This should reflect
terms from the Ethnomusicology controlled vocabulary that should be assigned to a record.
There should be a separate entry for each subject that appears on the record. For example:

<meta name='‘coverage' content="Turkey'>
<meta name=''coverage' content="Greece'>
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FORMATTING THE TEMPLATE BODY

The information in the template body controls how the record will display to users of the Greenstone
library. This information will mirror the information in the metadata header, but will be formatted for
display rather than search and retrieval. It will also include the links to the image and sound files associated
with the record.

A NOTE ON DIACRITICS

Because the Archives often deal with information that needs diacritics to display propetly, catalogers may
need to reference Unicode standards to ensure that diacritics will display propetly across all browsers.
(Browser that are not displaying Unicode may need to have their display settings changed to see the
diacritics)

Diacritics are formatted in HTML by using the symbols &# followed by a numeric hex code and ended
with a semi-colon.

For example, to display Gluck’s name with an umlaut in HTML, the code would look like
Glu&#0030E;ck

This will then display on the web in Greenstone as:

Glick

Bolding is only displayed to highlight the characters that represent the iy it will not appear bold in the Greenstone display.
A good reference for diacritics is available at:

http://www.alanwood.net/unicode/combining diacritical marks.html

Be sure to use the code in the column marked “Hex” as it is the most standard. More information about
diacritics in Unicode can be viewed at:

http://www.unicode.org/charts
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Linking Image Files

The template body begins with the formatting for any associated image files.

The image code in the template will look like this:
<td width=""21%" height="320">
<p><img src=""" width="150" height="150" align="‘center'></p>
<p><img src=""" width="150" height="150" align="'center'></p>
</td>
The file name(s) should match the name of the HTML file for the record, as mentioned in the
file naming instructions.

Each file should be entered separately. Code for two image files associated with record that has
the inventory number 123 would look like this:
<td width="21%" height="320">
<p><img src="123 1.jpg" width="144" height="150" align="‘center''></p>
<p><img src="123 2.jpg" width=""144" height="150" align="'center'></p>
</td>
The template defaults to code for two images, which is the most common association that will
occur in the 78 rpm collection. However, there could be one or none.

Additional images can be added by copying this line of code before the </td> tag:

<p><img src="123_2.jpg" width="144" height="150" align="‘center''></p>
There may be times when the images for a record have not been scanned yet. Do not delete the
code, because the images may be scanned and added at a later date. Instead, comment the code
out with <!--and -->so that it will not appear in the display. Commented code will looked like
this:
<I--<td width="21%" height="320">

<p><img src=""" width="150" height="150" align="‘center'></p>

<p><img src=""" width="150" height="150" align="'center'></p>
</td>-->
When image files are ready, import them into Greenstone, open the corresponding HTML file
located in the collection/<collectionname>/import folder, remove the comments, and add the
file names. The images will appear the next time the collection is built.
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Display formatting for metadata

This section provides examples and instructions for formatting metadata in the body of the
HTML template.

The metadata labels for display are already built into the template. For each piece of
information (titles, performers, etc), there a set of two HTML tags: one for the label and one for
the value that will display.

These labels will not be formatted exactly like the names of the metadata labels. This is because
albumTitle might not make a lot of sense displaying to digital library users. The following table
shows how the labels translate from the metadata headings to the display labels.

If there is a row in the display table for which a record does not have a value, delete that table
row from the HTML file. (Use the example for the table row that needs to be deleted to see
which code to delete.)

Metadata Label Display Label
albumTitle Album title
seriesInformation Series Information
inventoryNumber Inventory Number
matrixNumber Matrix Number
albumNumber Album Number
publisher Publisher

issued Date issued
physicalDescription Physical Description

note

Note(s)

accompanyingMaterial

Accompanying material

labellLanguage Language on the label
musicalWorkTitle Track title

alternative Alternate title
performancelanguage Language

petfBy Performed by
instrument Instrument(s)
composer Composer

lyricist Lyricist

subject Subject

coverage Geographic coverage

Use the examples on the following pages for instructions on how to format information
recorded in the display table.
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Example 1: Album Title (albumTitle)

This is how the code appears in the template:

<tr>
<td width="158"><div align="left""><strong>Album Title:</strong></div></td>
<td width="317"><div align="left'"></div></td>

</tr>

The first set of <td> </td> tags should not be edited. This is what displays the label.

The Album Title value should be entered into the second set of <td></td> tags. The <div> tags
align the text with the left hand side of the column. Enter the value between these <div> tags
as follows:
<tr>
<td width="158"><div align="left"><strong>Album Title:</strong></div></td>
<td width="317"><div align="left"">Balkan 845</div></td>
</tr>

Follow this model of entry for each table row. The remaining examples will address specific
formatting issues only.

Example 2: Series Information (seriesInformation)

This is how the code appears in the template:

<tr>
<td><div align="left"><strong>Series Information:</strong></div></td>
<td><div align="left"></div></td>

</tr>

Record series information in this row of the table.

<tr>
<td><div align="left"><strong>Series Information:</strong></div></td>
<td><div align="left">Balkan Folk Recordings, volume l</div></td>
</tr>
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Example 3: Inventory Number (inventoryNumber)

This is how the code appears in the template:

<tr>
<td><div align="left"><strong>Inventory Number:</strong></div></td>
<td><div align="left"></div></td>

</tr>

There should only be one inventory number. Every record must have an inventory number
assigned by the archivist. It should be entered as follows:

<tr>
<td><div align="left"><strong>Inventory Number:</strong>
</div></td>
<td><div align="left">546</div></td>

</tr>

Example 4: Matrix Number (matrixNumber)

This is how the code appears in the template:

<tr>
<td><div align="left"><strong>Matrix Number:</strong></div></td>
<td><div align="left"></div></td>

</tr>

There may be more than one matrix number for a record. They should be separated by a semi-
colon in the display.

<tr>
<td><div align="left""><strong>Matrix Number:</strong>
</div></td>
<td><div align="left"">845-A; 845-B</div></td>

</tr>

Example 5: Album Number (albumNumber)

This is how the code appears in the template:

<tr>
<td><div align="left"><strong>Album Number:</strong></div></td>
<td><div align="left"></div></td>

</tr>

There may be a more than one album number. They should be separated by a semi-colon in the
display.
<tr>

<td><div align="left"><strong>Album Number:</strong></div></td>

<td><div align=""left">Balkan 845-A; Balkan 845-B</div></td>
</tr>

36




Example 6: Publisher (publisher)

This is how the code appears in the template:

<tr>
<td><div align="left""><strong>Publisher:</strong></div></td>
<td><div align="left"></div></td>

</tr>

Record the publisher of the recording here.

<tr>
<td><div align="left"><strong>Publisher:</strong></div></td>
<td><div align="left">Balkan Phonograph Records</div></td>
</tr>

Example 7: Date Issued (issued)

This is how the code appears in the template:

<tr>
<td><div align="left""><strong>Date Issued:</strong>
</div></td>
<td><div align="left"></div></td>

</tr>

Record the published date of the recording as it appears on the record. It should be formatted
according to the profile of ISO 8601 defined here: http://www.w3.0org/TR/NOTE-datetime.
Most items will follow either the YYYY-MM or YYYY formats. If no date appears on the item,
use “n.d.” as the value.

<tr>
<td><div align="left"><strong>Date Issued:</strong></div></td>
<td><div align="left">1932</div></td>

</tr>

OR

<tr>
<td><div align="left"><strong>Date Issued:</strong></div></td>
<td><div align="left">1932-11</div></td>

</tr>
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Example 8: Physical Description (physicalDescription)

This is how the code appears in the template:

<tr>
<td><div align="left"><strong>Physical Description:</strong></div></td>
<td><div align="left"></div></td>

</tr>

Any necessary information about the physical description should be recorded here. This could
be rpm, size of the record (in inches, notated by "), or playback mode. Separate information
with semicolons. Permitted values for playback mode are:

e Mono
e stereo
<tr>

<td><div align="left"><strong>Physical Description:</strong></div></td>
<td><div align="left">78 rpm; 12 inches; mono</div></td>
</tr>

Example 9: Notes (notes)

This is how the code appears in the template:

<tr>
<td><div align="left""><strong>Notes:</strong></div></td>
<td><div align="left"></div></td>

</tr>

There may be notes from the record label, container, or accompanying material. Enter any
notes here as appropriate. All notes that were entered into the metadata header should be
included.

<tr>
<td><div align="left""><strong>Notes:</strong></div></td>
<td><div align=""left"> Recorded in Europe; Made in USA; Price -
$1.00</div></td>
</tr>
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Example 10: Accompanying Material (accompanyingMaterial)

This is how the code appears in the template:

<tr>
<td><div align="left""><strong>Accompanying Material :</strong>
</div></td>
<td><div align="left"></div></td>

</tr>

There may be label notes. Enter any notes from the label as appropriate. All accompanying
material noted in the metadata header should be included.

<tr>
<td><div align="left""><strong> Accompanying Material:</strong></div></td>
<td><div align="left">Cardboard album with notes on inside front cover,
photos on inside back cover</div></td>
</tr>

Example 11: Lanquage on the label (labelLanguage)

This is how the code appears in the template:

<tr>
<td><div align="left'"><strong>Language on the label:</strong>
</div></td>
<td><div align="left"></div></td>

</tr>

Record the language of text on the label. There may be more than one language; separate
languages by a semi-colon.

<tr>
<td><div align="left"><strong>Language on the label:</strong></div></td>
<td><div align="left">CGreek; Turkish</div></td>

</tr>

Example 12: Track title (musicalWorkTitle)

This is how the code appears in the template:

<tr>
<td><div align="left"><strong>Track title:</strong>
</div></td>
<td><div align="left"></div></td>

</tr>

List the track title as it appears on the record here.

<tr>
<td><div align="left"><strong>Track title:</strong></div></td>
<td><div align="left">Dhiamandoula mou</div></td>

</tr>
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Example 13: Alternate title (alternative)

This is how the code appears in the template:

<tr>
<td><div align="left""><strong>Alternate title:</strong>
</div></td>
<td><div align="left"></div></td>

</tr>

List any alternate well-known titles or alternate titles that appear on the record here.

<tr>
<td><div align="left""><strong>Alternate title:</strong></div></td>
<td><div align="left">Ela na se kano teri, Sirto Tsifte Telli</div></td>
</tr>

Example 14: Performed by (perfBy)

This is how the code appears in the template:

<tr>
<td><div align="left'"><strong>Performed by:</strong>
</div></td>
<td><div align="left"></div></td>

</tr>

Enter all performers appearing here. Include the performer’s role on the recording if known.
Separate performers from their role with a comma and from other performers with a semi-
colon.

<tr>
<td><div align="left"><strong>Performed by:</strong></div></td>
<td><div align="left"">Roza Eskinazi, vocalist; Joseph Benezra,
clarinet</div></td>

</tr>

Example 15: Instrument(s) (instrument)

This is how the code appears in the template:

<tr>
<td><div align="left"><strong>Instrument(s):</strong>
</div></td>
<td><div align="left"></div></td>

</tr>

Enter all instruments that appear on the record here. Separate items in the list with a comma.

<tr>
<td><div align="left"><strong>Instrument(s):</strong></div></td>
<td><div align="left"">vocals, clarinet</div></td>

</tr>
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Example 16: Language (performancelanguage)

This is how the code appears in the template:

<tr>
<td><div align="left""><strong>Language:</strong>
</div></td>
<td><div align="left"></div></td>

</tr>

Enter the language(s) that the track is performed in. Separate multiple languages with a
comma.

<tr>
<td><div align="left"><strong>Language:</strong></div></td>
<td><div align="left">Greek, Turkish</div></td>

</tr>

Example 17: Composer (composer)

This is how the code appears in the template:

<tr>
<td><div align="left""><strong>Composer:</strong>
</div></td>
<td><div align="left"></div></td>

</tr>

Enter the composer of the musical works that appear on the record.

<tr>
<td><div align=""left"><strong>Composer:</strong></div></td>
<td><div align="left">lannis Xenakis</div></td>

</tr>

Example 18: Lyricist (lyricist)

This is how the code appears in the template:

<tr>
<td><div align="left"><strong>Lyricist:</strong>
</div></td>
<td><div align="left"></div></td>

</tr>

Enter the composer of the musical works that appear on the record.

<tr>
<td><div align="left""><strong>Lyricist:</strong></div></td>
<td><div align="left">Nazim Hikmet</div></td>

</tr>
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Example 19: Sound file

This is how the code appears in the template:

<tr>
<td><div align="left"><strong>Sound file:</strong> </div></td>
<td><div align="left""><a href=""">Side 1l:</a><br>
<a href="">Side 2:</a></div></td>
</tr>

Enter the filename of the associated MP3 file to denote its location in the <a href=""> tag. The
files should be named to reflect the inventory number as noted in the file name instructions.
There is one MP3 for each side of the record.

<tr>
<td><div align="left"><strong>Sound file:</strong> </div></td>
<td><div align="left"><a href="123 1.mp3'>Side 1l:</a><br>
<a hre="123_2_mp3'">Side 2:</a></div></td>
</tr>

Example 20: Subject (subject)

This is how the code appears in the template:

<tr>
<td><div align="left"><strong>Subject:</strong>
</div></td>
<td><div align="left"></div></td>

</tr>

Enter the subjects assigned to the record. Multiple subjects should be separated by a <br> tag.
Subject should be chosen from the Ethnomusicology Subject Controlled Vocabulary.

<tr>
<td><div align="left""><strong>Subject:</strong>
</div></td>
<td><div align="left"">Songs<br>
Folk Music — Turkey</div></td>
</tr>
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Example 21: Geographic Coverage (coverage)

This is how the code appears in the template:

<tr>
<td><div align="left'"><strong>Geographic coverage:</strong></div></td>
<td><div align="left"></div></td>

</tr>

Enter the geographic coverage assigned to the record. Multiple geographic areas should be
separated by a <br> tag. Geographic regions should be chosen from the Ethnomusicology
Geographic Region Controlled Vocabulary.

<tr>
<td><div align="left""><strong>Geographic coverage:</strong></div></td>
<td><div align="left"> Greece<br>
Turkey</div></td>
</tr>

Save the record. The next section will go over how to add new records to the library.
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ADDING NEW RECORDS TO THE /8 RPM DIGITAL LIBRARY

Adding new records to the digital library is a simple process. Just follow the steps outlined below.

o PN o

Open the Greenstone Library Interface

Select File=> Open-> Ethnomusicology 78 rpm Library

Go to the Gather tab. The navigation bar will be on the left and the files currently in the library will
display on the right.

On the left hand side, navigate to where the new HTML files and associated JPG and MP3 files are
in the local directory.

Select the files and drag them to the collection that is open on the right hand side.

Go to the Create tab.

Select “Build Library...”

The library will build, and the log will populate in the window.

Preview the library when it has finished building and spot-check new records to make sure
everything is displaying correctly.

The library is now updated and records are available for library users!
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APPENDIX A: METADATA APPLICATION PROFILE

ETHNOMUSICOLOGY ALBUM METADATA SCHEMA

SCOPE

This application profile addresses metadata for the descriptions of published record albums in
ethnomusicology archives. The scope is limited to information necessary to describe the album and the
works represented on the album. This application profile does not address any issues related to methods of
preservation, acquisition or digitization of the content of these albums. The focus on published items also
affects the scope of this application by defining certain elements that are not represented in non-published
materials.

This application profile was developed for a local implementation. Because of limited local resources,
properties have not been declared with persistent URIs. If resources become available, the properties
enumerated in this profile could be assigned URISs. In anticipation of this future expansion, this profile
attempts to address issues of interoperability to meet the needs of repositories and aggregators.

Community of Practice

Ethnomusicology students and scholars are the primary community being served by this application profile.
Secondary users include archivists, music enthusiasts, and record collectors.

FUNCTIONAL REQUIREMENTS

Fielded Searching for Albums
Reguirement: Users should be able to search any or all of the properties representing the physical album

described in the profile, particularly the album title, publisher, publication date, and matrix number.
Usage Scenario: Primaries users will need the facility to search the system for items based on one or a
combination of these criteria relating to the content of the album.

Proposed Solution: AlbumTitle, Publisher, PublicationDate, Matrix, LabellL.anguage, and CoverLanguage
properties.

Fielded Searching for Content Relating to Albums, Performances, Musical Works and Agents
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Reguirement: Users should be able to search by any or all elements that represent the content of the album
described in the profile, particularly the elements of title of a musical work, cultural group, content language,
geographic coverage, and performer.

Usage Scenario: Primary users will need the facility to search the system for items based on one or a
combination of these criteria relating to the content of the album or the album itself.

Proposed Solution: Musical Work Title, Performer, Instrumentation, Cultural Context, and Coverage
properties.

Multiple Musical Work Titles
Reguirement: All musical works that appear on an album must be represented in the metadata.

Usage Scenario: Published albums generally include more than one performance, and each performance is a
version of a musical work. Title access to each of these musical works should be provided.
Proposed Solution: Allow multiple instances of musical work titles.

Alternative Musical Work Titles

Reguirement: Musical works may have alternative titles or titles that appear in more than one language.

Usage Scenario: Users may be familiar with a musical work under one working title, but a performance of that
musical work may have been published under a different title.

Proposed Solution: Alternative property for alternative musical work titles.

Authority
Reguirement: When appropriate, authority files should be used to disambiguate values for resources.

Usage Scenario: Aggregators and users may be confused by similar performer names or ambiguous names for
countries or geographic regions that have changed over time.
Proposed Solution: Require the use of authority files for Creator property.

Controlled Vocabulary

Reguirement: Support disambiguation and browsing for terms that may have variations across time and
cultural groups.

Usage Scenario: Thesauri such as the new Ethnographic Thesaurus should be used to provide control and
support aggregation of terms that can be controlled through discipline-specific vocabularies.

Proposed Solution: Instrument, Cultural Context, Coverage, and Subject properties will allow for vocabulary
encoding schemes.

Date

Requirement: Support access to published materials by publication date.

Usage Scenario: Aggregators may not be able to disambiguate between dates from an item published in
country X that uses one date format and country Y that uses another date format.

Proposed Solution: Publication Date will allow for a syntax encoding scheme.
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THE MODEL

Album

publishedBy

hasPart

A

isPartOf

Performamnce

performedBy
assoclatedWlith

IsVerdonOf

IsRepresentedBy

Musieal\Aomk

Digital File
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TERM DECLARATIONS AND DC TEXT EXAMPLES

Namespaces

dc: http://purl.org/dc/terms/

Album Entity

Property Name albumTitle
Type of Term Property
Subproperty Of dc:title

http://purl.org/dc/terms/title

Source Label

Title

Label in this AP

Album Title

Source Definition

A name given to the resource.

Usage in this AP

A name given to the collection of musical works contained on a
record album.

Comments in this
AP

A value string must be provided.

Titles can be recorded in multiple languages by using multiple
statements; each statement must be associated with the appropriate

language tag.

Value: Literal

Mandatory.

Language URI mandatory.

Value: Non-Literal

Not permitted

Obligation Recommended
Minimum 0
Occutrrences

Maximum Unbounded
Occurrences

48


http://purl.org/dc/terms/abstract
http://purl.org/dc/terms/title

Property Name seriesInformation
Type of Term Property
Subproperty Of dc:title

http://putl.org/dc/terms/title

Source Label

Title

Label in this AP

Series Information

Source Definition

A name given to the resource.

Usage in this AP

A name of the series to which a resource belongs.

Comments in this
AP

A value string must be provided.

Series information can be recorded in multiple languages by using
multiple statements; each statement must be associated with the
appropriate language tag.

Value: Literal

Mandatory.

Language URI mandatory.

Value: Non-Literal

Not permitted

Obligation Recommended
Minimum 0
Occurrences

Maximum Unbounded
Occutrrences
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http://purl.org/dc/terms/title

Property Name inventoryNumber
Type of Term Property
Subproperty Of dc:identifier

http://purl.org/dc/terms/identifier

Source Label

Identifier

Label in this AP

Inventory Number

Source Definition

An unambiguous reference to the resource within a given context.

Usage in this AP

The number used to identify the resource within the UW
Ethnomusicology Archive collection.

Comments in this
AP

Represented by a value string.

Value: Literal

Mandatory

Language URI not permitted.

Value: Non-Literal

Not permitted

Obligation Recommended
Property Condition | [N/A]
Minimum 0
Occutrrences

Maximum Unbounded
Occurrences
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http://purl.org/dc/terms/identifier

Property Name matrixNumber
Type of Term Property
Subproperty Of dc:identifier

http://putl.org/dc/terms/identifier

Source Label

Identifier

Label in this AP

Matrix number

Source Definition

An unambiguous reference to the resource within a given context.

Usage in this AP

The number stamped on the actual album in the run off (the band
of blank vinyl between the label and the end of the recorded
material) that a record company uses to reference the original
master recording.

Comments in this
AP

Represented by a value string.

Value: Literal

Mandatory
Language URI not permitted

Value: Non-Literal

Not permitted

Obligation Recommended
Property Condition | [N/A]
Minimum 0
Occurrences

Maximum 1

Occurrences
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http://purl.org/dc/terms/identifier

Property Name albumNumber

Type of Term Property

Subproperty Of dc:identifier
http://purl.org/dc/terms/identifier

Source Label Identifier

Label in this AP Album Number

Source Definition

An unambiguous reference to the resource within a given context.

Usage in this AP

Any number other than the matrix number printed on the record
label by the publisher for identification.

Comments in this
AP

Represented by a value string.

Value: Literal

Mandatory

Language URI not permitted.

Value: Non-Literal

Not permitted

Obligation Recommended
Property Condition | [N/A]
Minimum 0
Occurrences

Maximum Unbounded
Occurrences
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http://purl.org/dc/terms/identifier

Property Name collection

Type of Term Property

Subproperty Of dc:identifier
http://purl.org/dc/terms/identifier

Source Label Identifier

Label in this AP Collection

Source Definition

An unambiguous reference to the resource within a given context.

Usage in this AP

An unambiguous collection number given to the resource.

Comments in this
AP

Represented by a value string.

Value: Literal

Mandatory

Language URI not permitted.

Value: Non-Literal

Not permitted

Obligation Recommended
Property Condition | [N/A]
Minimum 0
Occurrences

Maximum Unbounded
Occutrrences
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http://purl.org/dc/terms/identifier

Property URI http://putl.org/dc/terms/issued
Property Name dcterms:issued

Defined By http://putl.org/dc/terms/
Type of Term Property-refinement
Subproperty Of dc:date

Source Label Issued

Label in this AP

Source Definition

Date of formal issuance (e.g., publication) of the resource.

Usage in this AP

Date of publication of the record album.

Comments in this AP

Value: Literal

Allowed
SES: Required
http://putl.org/dc/terms/W3CDTF

Value: Non-Literal

Not permitted

Obligation Recommended
Property Condition [N/A]
Minimum 0
Occutrrences

Maximum 1
Occurrences
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http://purl.org/dc/terms/issued
http://purl.org/dc/terms/W3CDTF

Property Name note
Type of Term Sub Property
Subproperty Of dc: description

http://purl.org/dc/terms/description

Source Label

Description

Label in this AP

Label Notes

Source Definition

Description may include but is not limited to: an abstract, a table of
contents, a graphical representation, or a free-text account of the

resource.

Usage in this AP

Description of any notes present on the record album label or
accompanying material. May also include descriptive information
such as the condition of the resource.

Comments in this
AP

Value string required.

Value: Literal

Allowed

Value: Non-Literal

Not permitted

Obligation Recommended
Minimum 0
Occutrrences

Maximum 1

Occutrrences
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http://purl.org/dc/terms/description

Property Name labellLanguage

Type of Term Sub Property

Subproperty Of dc: language
http://purl.org/dc/terms/language

Source Label Language

Label in this AP Label Language

Source Definition

The language of the resource.

Usage in this AP

The language of the record album label.

Comments in this
AP

Value string required.

Value: Literal

Allowed

Value: Non-Literal

Not permitted

Obligation Recommended
Minimum 0
Occutrrences

Maximum 1

Occurrences
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http://purl.org/dc/terms/language

Property Name accompanyingMaterial
Type of Term Property
Subproperty Of -

Source Label accompanyingMaterial

Label in this AP

Source Definition

Description of any accompanying notes, graphics or other
ephemera that is packaged with the record album.

Usage in this AP

Comments in this
AP

Value string required.

Value: Literal

Allowed

Value: Non-Literal

Not permitted

Obligation Recommended
Minimum 0
Occurrences

Maximum 1

Occurrences
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Property Name labellmage
Type of Term Sub-Property
Subproperty Of dc:description

http://putl.org/dc/clements/1.1/description

Source Label

Description

Label in this AP

Label Image

Source Definition

Description may include but is not limited to: an abstract, a table of
contents, a graphical representation, or a free-text account of the

resource.

Usage in this AP

An image file describing the label of the album.

Comments in this
AP

Value string required.

Value: Literal

Allowed

Value: Non-Literal

Not permitted

Obligation Recommended
Minimum 0
Occutrrences

Maximum Unbounded
Occurrences
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http://purl.org/dc/elements/1.1/description

Property Name physicalDescription

Type of Term Property

Subproperty Of dc:format
http://purl.org/dc/elements/1.1/format

Source Label Format

Label in this AP Physical Description

Source Definition

The file format, physical medium, or dimensions of the resource.

Usage in this AP

The physical description, including playing speed and size, of the
record album.

Comments in this AP

Value string required.

Value strings maintained in a local vocabulary encoding scheme.

Value: Literal

Mandatory

Value: Non-Literal

Not permitted

Obligation Recommended
Property Condition [N/A]
Minimum 1

Occurrences

Maximum 1

Occurrences
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http://purl.org/dc/elements/1.1/format

Agent Entity

Property URI http://putl.org/dc/elements/1.1/publisher
Property Name dc:publisher

Defined By http://putl.otg/dc/elements/

Type of Term Property

Subproperty Of --

Source Label Publisher

Label in this AP

Source Definition

An entity responsible for making the resource available.

Usage in this AP

The person, organization or service that is the publisher of the album.

Comments in this AP

Examples of a Publisher include a person, an organization, or a service.

Value: Literal

Mandatory

Value: Non-Literal

Not permitted

Obligation Recommended
Property Condition [IN/A]
Minimum Occurrences | 0

Maximum Occurrences | 1
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http://purl.org/dc/elements/1.1/publisher

Performance Entity

Property Name perfBy
Defined By -

Type of Term Property
Subproperty Of -

Source Label Performer

Label in this AP

Source Definition

The described performance is performed by the referenced performer.

Usage in this AP

Comments in this
AP

Value: Literal Allowed

Value: Non-Literal Value URI allowed
Obligation Recommended
Property Condition | [N/A]

Minimum 1

Occutrrences

Maximum Unbounded
Occurrences
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Property Name instrument
Type of Term Property
Subproperty Of -

Source Label Instruments

Label in this AP

Source Definition

The instruments that used in the performance.

Usage in this AP

Comments in this
AP

A value string must be provided. The Ethnomusicology department
instrument controlled vocabulary should be used.

Value: Literal

Allowed

Value: Non-Literal

--Value URI allowed
—Vocabulary Encoding Scheme URI:

1. http://www.ietf.org/rfc/rfc3066.txt
2. In-house Ethnomusicology controlled vocabulary
—Value string conditional

--Language URI [N/A]
--Syntax Encoding Scheme URI: [N/A]

Obligation Recommended
Property Condition | [N/A]
Minimum 1

Occurrences

Maximum Unbounded
Occutrrences
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Property Name performancellanguage

Type of Term Sub Property

Subproperty Of dc: language
http://purl.org/dc/elements/1.1/language

Source Label Language

Label in this AP

Performance Language

Source Definition

The language of the resource.

Usage in this AP

The language of any spoken or sung words in the performance.

Comments in this
AP

Value string required.

Value: Literal

Allowed

Value: Non-Literal

Not permitted

Obligation Recommended
Minimum 0
Occurrences

Maximum 1
Occutrrences
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Musical Work Entity

Property Name musical WorkTitle
Type of Term Sub Property
Subproperty Of dc:title

http://purl.org/dc/elements/1.1/title

Source Label

Title

Label in this AP

Musical Work Title

Source Definition

A name given to the resource.

Usage in this AP

The name by which a musical work is known.

Comments in this AP

The chief source of information for the musical work title should be
taken the label of the record album. Other prescribed sources are
the album cover or accompanying materials.

Value: Literal

Allowed

Value: Non-Literal

Not allowed

Obligation Mandatory
Property Condition -
Minimum 1
Occurrences

Maximum 1
Occutrrences
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Property Name dc:alternative

Property URI http://purl.org/dc/terms/alternative

Defined By http://putl.org/dc/terms/

Type of Term Property-refinement

Subproperty Of dc:title
http://putl.org/dc/elements/1.1/title

Source Label Alternative

Label in this AP

Alternative Title

Source Definition

A variant form of the title by which a work is also known.

Usage in this AP

Comments in this
AP

Variant titles include titles that appear on the record album cover,
translations of musical work titles, variant titles by which the user
community knows the musical work, and variant titles as noted in the
authority file of the musical work title.

Value: Literal Allowed
Value: Non-Literal Not allowed
Obligation Recommended
Property Condition | --

Minimum 0
Occurrences

Maximum Unbounded
Occutrrences
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http://purl.org/dc/terms/alternative
http://purl.org/dc/elements/1.1/title

Property Name composer
Type of Term Sub Property
Subproperty Of dc:creator

http://purl.org/dc/elements/1.1/creator

Source Label

Composer

Label in this AP

Source Definition

The composer is the individual(s) or group that is the primary creator
responsible for the musical content of a musical work.

Usage in this AP

Comments in this AP

A value string must be provided.

Value: Literal Allowed
Value: Non-Literal Not allowed
Obligation Recommended
Property Condition [IN/A]
Minimum 0
Occurrences

Maximum Unbounded
Occurrences
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Property Name lyricist

Type of Term Sub Property
Subproperty Of dc:creator
Source Label Lyricisit

Label in this AP

Source Definition

The lyricist is the individual(s) or group that is the primary creator of
any spoken or sung text that is part of a musical work.

Usage in this AP

Comments in this AP

A value string must be provided.

Value: Literal Allowed
Value: Non-Literal Not allowed
Obligation Recommended
Property Condition [N/A]
Minimum 0
Occurrences

Maximum Unbounded
Occutrrences
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Property URI http://purl.org/dc/terms/subject
Property Name dc:subject

Defined By http://putl.org/dc/terms/

Type of Term Property

Subproperty Of -

Source Label Subject

Label in this AP Subject

Source Definition

The topic of the resource.

Usage in this AP

Topical terms that describe the musical work represented by the
performance.

Comments in this AP

A value string must be provided.

Value: Literal

Allowed

Value: Non-Literal

--Value URI allowed
—Vocabulary Encoding Scheme URI:

1. http://www.ietf.org/rfc/rfc3066.txt
2. In-house Ethnomusicology controlled vocabulary
—Value string conditional

--Language URI [N/A]
--Syntax Encoding Scheme URI: [N/A]

Obligation

Recommended

Property Condition

Non-literal values defined by the suggested controlled vocabularies
are preferred; literal values are acceptable when no acceptable term is

available in the recommended vocabularies.

Minimum 0
Occurrences

Maximum Unbounded
Occurrences
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http://www.ietf.org/rfc/rfc3066.txt

Property URI http://purl.org/dc/terms/coverage
Property Name dc: coverage

Defined By http://putl.otg/dc/terms/

Type of Term Property

Subproperty Of [N/A]

Source Label Coverage

Label in this AP

Source Definition

The spatial or temporal topic of the resource, the spatial applicability
of the resource, or the jurisdiction under which the resource is

relevant.

Usage in this AP

The country, city or geographic region associated with a musical work.

Comments in this
AP

Value string required.

Value: Literal

Allowed

Value: Non-Literal

--Value URI allowed
—Vocabulary Encoding Scheme URI:

1. http://www.ietf.org/rfc/rfc3066.txt
2. Human Relations Area Files
—Value string conditional

--Language URI required
--Syntax Encoding Scheme URI: [N/A]

Obligation

Recommended

Property Condition

Literals should only be used if the appropriate geographic name does
not appear in the suggested vocabularies and metadata generators do
not have permission to include them in said authority files.

Minimum 0
Occurrences

Maximum Unbounded
Occurrences
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Digital File Entity

Property Name fileName
Type of Term Sub Property
Subproperty Of dc:title

http://putl.org/dc/elements/1.1/title

Source Label

Title

Label in this AP

File Name

Source Definition

A name given to the resource.

Usage in this AP The name by which the digital sound file associated with a resource is
known..

Comments in this --

AP

Value: Literal Allowed

Value: Non-Literal Not allowed

Obligation Mandatory

Property Condition | --

Minimum 1

Occurrences

Maximum Unbounded

Occurrences
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APPENDIX B : COMPLETED TEMPLATE EXAMPLES

EXAMPLE 1

<IDOCTYPE HTML PUBLIC ""-//W3C//DTD HTML 4.01 Transitional//EN">

<html>

<head>

<I--This is where the metadata needs to be entered so that the record can be
searched. Fields should

be repeated if there is more than one metadata value. ITf there is a field that has
no value for a

record, delete that field from the template.-->

<title>Balkan 40l1l4</title>
<meta name="albumTitle" content="Balkan 4014'>
<meta name="inventoryNumber' content="312">
<meta name=''collection” content="91-13.1 WD">
<meta name="'matrixNumber' content=""4014A">
<meta name="matrixNumber' content="4014B">
<meta name="albumNumber' content="Balkan 4014-A"">
<meta name="albumNumber' content="Balkan 4014-B'>
<meta name="publisher"™ content="Balkan Phonograph Records'>
<meta name="physicalDescription' content="78 rpm, mono, 10>
<meta name="issued" content="n.d.">
<meta name='‘note" content="Label — Price - $1.00, Made in USA, Recorded in
Europe; includes “Keman, Ut, Klarinet, Piyano, Darbuka, Zil'"'>
<meta name="labellLanguage' content=""Turkish">
<meta name="musicalWorkTitle" content="Adalar Sahilinde'>
<meta name="musicalWorkTitle" content=""Nazli Guzel Bebecigim'>
<meta name="perfBy" content="Garbis Kanuni''>
<meta name="instrument' content="Kanun'>
<meta name="'subject' content=""Instrumental music--Turkey'>
<meta name="'‘coverage' content="Turkey'>
<meta http-equiv=""Content-Type"
content=""text/html; charset=windows-1252"">
<meta http-equiv=""Content-Language' content="en-us'>
</head>

<body Bink="#0000FF'" vlink="#0000FF'" alink="#0000FF">

<p>&nbsp;</p>
<p>&nbsp;</p>
<p>&nbsp;</p>
<p>&nbsp;</p>

<table width="75%" border="0" align="left" cellpadding="10">
<tr>
<l--Enter any images associated with the record album in this part of the table-->
<td width="21%" height="320">
<p><img src=""312 1.jpg" width="150" height=""150" align="left"></p>
<p><img src=""312 2.jpg" width="150" height=""150" align="left"></p>
</td>
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<I--This table is where the display information should be entered. Display
information should be entered according to the guidelines in the cataloging manual
which lives at Xxxx-->

<td width="79%" rowspan="2">
<table width="493" border="0" cellpadding="7" align="'center">
<tr>
<td width="158"><div align=""left"><strong>Album Title:</strong> </div></td>
<td width=""317"><div align="left">Balkan 4014</div></td>
</tr>
<tr>
<td><div align="left""><strong>Inventory Number:</strong> </div></td>
<td><div align=""left'">312</div></td>
</tr>
<tr>
<td><div align="left"><strong>Collection:</strong> </div></td>
<td><div align="left'">91-13.1 WD</div></td>
</tr>
<tr>
<td><div align="left""><strong>Matrix Number:</strong> </div></td>
<td><div align="left"">4014A; 4014B</div></td>
</tr>
<tr>
<td><div align="left""><strong>Publisher:</strong> </div></td>
<td><div align="left"">Balkan Phonograph Records</div></td>
</tr>
<tr>
<td><div align="left"><strong>Date issued:</strong> </div></td>
<td><div align="left">n.d.</div></td>
</tr>
<tr>
<td><div align="left"><strong>Physical descrption:</strong> </div></td>
<td><div align="left">78 rpm; mono; 10"</div></td>
</tr>
<tr>
<td><div align=""left""><strong>Note(s):</strong> </div></td>
<td><div align="left">Label — Price - $1.00, Made in USA, Recorded in Europe;
includes “Keman, Ut, Klarinet, Piyano, Darbuka, Zil”’</div></td>
</tr>
<tr>
<td><div align=""left"><strong>Language on the label:</strong> </div></td>
<td><div align="left">Turkish</div></td>
</tr>
<tr>
<td><div align="left""><strong>Track title(s):</strong> </div></td>
<td><div align="left">Side 1: Adalar Sahilinde<br>
Side 2: Nazli Guzel Bebecigim</div></td>
</tr>
<tr>
<td><div align="left""><strong>Performed by:</strong> </div></td>
<td><div align="left">Garbis Kanuni</div></td>
</tr>
<tr>
<td><div align="left""><strong>Instrument(s):</strong> </div></td>
<td><div align=""left">Kanun</div></td>
</tr>
<tr>




<td><div align="left"><strong>Sound file:</strong> </div></td>
<td><div align="left"><a href="312_1.mp3'">Side 1</a><br>
<a href="312_2._.mp3">Side 2</a></div></td>
</tr>
<tr>
<td><div align="left"><strong>Subject:</strong></div></td>
<td><div align="left">Instrumental music--Turkey</div></td>
</tr>
<tr>
<td><div align="left""><strong>Coverage: </strong></div></td>
<td><div align="left">Turkey</div></td>
</tr>
</table></td>
</tr>
<tr>
<td>&nbsp;</td>
</tr>
</table>
</body>
</html>

EXAMPLE 2

<IDOCTYPE HTML PUBLIC **-//W3C//DTD HTML 4.01 Transitional//EN">

<html>

<head>

<I--This is where the metadata needs to be entered so that the record can be
searched. Fields should be repeated if there is more than one metadata value. IT
there is a field that has no value for a record, delete that field from the
template.-->

<title>Victor Record 63056</title>

<meta name="albumTitle"™ content="Victor Record 63056'>

<meta name=""inventoryNumber™ content='"473">

<meta name='"collection” content='"2005-9.1 WD'>

<meta name="matrixNumber' content="16696A / 12584 b">

<meta name="'matrixNumber’ content=""16696B / 12585 b'>

<meta name="matrixNumber' content="D 63056A">

<meta name="matrixNumber' content="D 63056B">

<meta name="albumNumber' content=""63056-A"">

<meta name="albumNumber' content="'63056-B"">

<meta name="publisher™ content="Victor Talking Machine Co.'">
<meta name='physicalDescription' content="78 rpm, mono, 10'">
<meta name="issued" content="n.d.">

<meta name='note' content="Label — Turkish Band'>

<meta name="labellLanguage' content="English">

<meta name="musicalWorkTitle" content="Meboussan Marche'>
<meta name="musicalWorkTitle'" content="Milet Osmani Marche'>
<meta name="'perfBy" content="Musique du Palais Impérial (Constantinople)'>
<meta name="instrument" content="Military Band">

<meta name="'subject' content=""Instrumental Music--Turkey'>
<meta name='‘coverage' content="Turkey">

<meta http-equiv=""Content-Type"
content=""text/html; charset=windows-1252"">

<meta http-equiv=""Content-Language' content="en-us''>
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</head>
<body link="#0000FF" vIlink="#0000FF" alink="#0000FF">

<p>&nbsp;</p>
<p>&nbsp;</p>
<p>&nbsp;</p>
<p>&nbsp;</p>

<table width="75%" border="0" align="left" cellpadding="10">
<tr>
<I-—Enter any images associated with the record album in this part of the table-->
<td width="21%" height="320">
<l--<p><img src="473_1._jpg" width="150" height=""150" align=""left"></p>
<p><img src=""473 2.jpg" width="150" height="150" align="left"></p>-->
</td>

<I--This table is where the display information should be entered. Display
information should be entered according to the guidelines in the cataloging manual
which lives at xxXxx-->

<td width="79%" rowspan="2">
<table width="493" border="0" cellpadding="7" align="'center">
<tr>
<td width="158"><div align="left'"><strong>Album Title:</strong> </div></td>
<td width="317"><div align="left">Victor Record 63056</div></td>
</tr>
<tr>
<td><div align="left""><strong>Inventory Number:</strong> </div></td>
<td><div align="left">472/div></td>
</tr>
<tr>
<td><div align="left"><strong>Collection:</strong> </div></td>
<td><div align="left'">2005-9.1 WD</div></td>
</tr>
<tr>
<td><div align=""left"><strong>Matrix Number:</strong> </div></td>
<td><div align=""1eft'">16696A / 12584 b; 16696B / 12585 b ; D 63056A ; D
63056B</div></td>
</tr>
<tr>
<td><div align="left"><strong>Album Number:</strong> </div></td>
<td><div align="left">63056-A ; 63056-B</div></td>
</tr>
<tr>
<td><div align="left""><strong>Publisher:</strong> </div></td>
<td><div align="left">Victor Talking Machine Co.</div></td>
</tr>
<tr>
<td><div align="left"><strong>Date issued:</strong> </div></td>
<td><div align="left">n.d.</div></td>
</tr>
<tr>
<td><div align="left"><strong>Physical descrption:</strong> </div></td>
<td><div align="left">78 rpm; mono; 10"</div></td>
</tr>
<tr>
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<td><div
<td><div

</tr>

<tr>
<td><div
<td><div

</tr>

<tr>
<td><div
<td><div

</tr>

<tr>

<tr>
<td><div
<td><div

</tr>

<tr>
<td><div
<td><div

</tr>

<tr>
<td><div
<td><div

</tr>

<tr>
<td><div
<td><div

</tr>

<tr>
<td><div
<td><div

</tr>

</table></td>
</tr>
<tr>
<td>&
</tr>
</table>
</body>
</html>

align="left'
align="left'
align="left'
align="left'
align="left
align="left'
align="left'
align="left'
align="left"
align="left"
align=""left"
align="left"
align=""left"
align="left"
align="left"
align="left"
nbsp;</td>

'><strong>Note(s):</strong> </div></td>
'>Label — Turkish Band</div></td>

'><strong>Language on the label:</strong> </div></td>
'>English</div></td>

'><strong>Track title(s):</strong> </div></td>
'>Side 1: Meboussan Marche<br>

Side 2: Milet Osmani Marche</div></td>

'><strong>Performed by:</strong> </div></td>
'>Musique du Palais Impérial (Constantinople)</div></td>

><strong>Instrument(s):</strong> </div></td>
>Military Band</div></td>

><strong>Sound file:</strong> </div></td>
><a href="473_1.mp3'">Side 1</a><br>
<a href="473_2.mp3'">Side 2</a></div></td>

><strong>Subject:</strong></div></td>
>Instrumental Music--Turkey</div></td>

><strong>Geographic Coverage:</strong></div></td>
>Turkey</div></td>
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APPENDIX C: RESOURCES FOR CUSTOMIZATION

http:/ /www.wrtlc.org/dcpc/Userlnterface/interface.htm

http:/ /wiki.greenstone.org/wiki/index.php/Customizing_your_Greenstone_library

http:/ /wiki.greenstone.org/wiki/index.php/A_basic_introduction_to_using CSS_in_Greenstone
http://greenstonesupport.iimk.ac.in/Documents/Customizing%o20gsdl.pdf
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http://greenstonesupport.iimk.ac.in/Documents/Customizing%20gsdl.pdf
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